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Lesson Plan

Students will learn the basic Microsoft Word skills needed to write a letter.

Lesson Objectives.
The student will understand and can accomplish these tasks at the end of the lesson:
· Be able to Open new and existing documents. 
· Be able to copy and paste text.
· Be able to use the Undo/Redo function.
· Be able to format font by selecting font type, size and color and using bold, italic, underline and highlighter tools.
· Be able to format paragraphs via alignment, bullets, numbering and line spacing.
· Be able to manipulate document margins.
· Be able to Save documents.
· Be able to print documents.


Lesson Prep Work.
(30 min, at a minimum, prior to student arrival).
· get in early to test for technology failure, because it will happen :-).
· save Basics Example Letter.docx to the desktop on each computer.
· print handouts.

Lesson Prerequisites.
· The Computer Basics series or equivalent skills

Lesson Outline.
The lesson is completed in one 120 minute class session.
(5 min) Introduction.
· Introduce instructor, students.
· Let students know it’s okay to take phone calls, but ask them to put their phone on vibrate and answer calls outside the classroom.
· Inform students that they can sit back and watch if the class is too advanced.
· Inform students they can go to the bathroom, they don’t need permission.
· State/show order in which class will happen. Explain scope of class.


(5) Overview of Office 
· What is Word and what is it used for?
· Open Basics Example Letter.docx
· Open a New Word document from the start menu.
· Explore the ribbon/switch between Home tab and Page Layout tab.
· Discuss the purposes of these tabs (the rest will be advanced).
· File = printing and saving.
· Home = options that you will use more frequently.
· Page Layout = options to change how the page will print (e.g. margins).
· Show how to minimize and restore the ribbon by double clicking on one of the tabs.

(5) Keyboard buttons
· Placing the Cursor and Selecting.
· A computer doesn’t know what you want it to do until you tell it.
· Changes will be made from where the black blinking line appears.
· Highlighting changes text in bulk.
· Enter – actually starts a new paragraph, even if you only have a couple of words on the line.
· Activity: Start a new paragraph after the date.
· Click after “June 1st, 2012”.
· Press enter.
· Point out that it starts a new paragraph.
· The paragraph started where the cursor was when you hit enter.
· Comprehension Check: Everyone clicks after “Dear Mom,” and presses enter.
· Backspace – removes characters behind the cursor.
· Activity: Backspace out the date and type in the correct date.
· Place the cursor after the date.
· Hit backspace until it is gone.
· Type in the correct Date
· Comprehension Check: Backspace out “your Daughter” and have type in your name.

(15) Copy and Paste
· Explanation/Discussion
· Copy and paste allows you to take text from one place and move it to another. 
· Some job search sites require you to copy and paste in your resume.
· This shortcut saves you from re-typing the entire document.
· Activity: Copy and paste the text from Basics Example Letter.docx to your blank document.
· Step 1 – Select all the text in Basics Example Letter.docx by clicking and dragging.
· Teacher’s Tip: This is generally done better if you demonstrate the process for everyone first, then have them follow along. 
· Step 2 – Right click on the selected text.
· Teacher’s Tip: make sure students right click on the text. If they right click on any of the menus in Word, they get different options.
· Step 3 – Select Copy.
· Step 4 – Open the New Document from the taskbar.
· Teacher’s Tip: Remind students of the taskbar. When you hover on the Word icon, you can see the full list of documents you currently have open.
· Step 5 – Right click in the blank space of your new document.
· Teacher’s Tip: remind students to right click in the space they want their text to appear. If they right click on menus, it will give them different options.
· Step 6 – Select Paste.
· Teacher’s Tip: Running through all the Paste Options is a little too much at this stage. For now, teach them to select the option with an “A” over the clipboard.
· Comprehension Check: Students copy and paste just the first paragraph.
· Ask students to delete their text first. Ask them what keyboard key to use.
· Instructor walks around the room to assists students who fall behind.
· Practice copy and paste at least 2 more times, ending with all the text from Basics Example Letter.docx in your new document.

(10) Formatting Font
· Explanation/Discussion
· Ask students: “What is font?”
· Metaphor: the handwriting of the computer. Just like each student in the class writes with a different style, the computer can write in different styles as well. 
· Elements of font: shape of the letters (font face), color, size, thickness, etc.
· Activity: Modify the font of the first paragraph.
· Explain: Whenever you want to edit something on the computer, the first thing you have to do is select what you want to change.
· Change the Font Face:
· Step 1 – Select the first paragraph by clicking and dragging.
· Step 2 – Click on the arrow beside the font face selector.
· Teacher’s Tip: point out that arrows are everywhere in Word. Students can find them in other software as well. Arrows mean options. 
· Step 3 – Hover over several font faces. Point out how you can see the paragraph changing in the background before you commit to a font face.
· Step 4 – select a favorite font face, if you struggle, select Arial.
· Change the font size.
· The first paragraph is still selected from when we changed the font face.
· Step 1 – Click on the arrow beside the font size.
· Step 2 – Hover over different font sizes. Again, we see the paragraph changing in the background.
· Step 3 – Select a font size, if you struggle, select size 16.
· Change the font color.
· Point out that our first paragraph is already selected.
· Step 1 – Click on the “A” with the red underline under it.
· This automatically changed our font to red.
· Ask students: “what do you see beside this button?”
· An arrow! Which means options!
· Step 2 – Click on the arrow beside the font color button.
· Step 3 – Hover over different colors to show how the paragraph will change.
· Step 4 – Select your favorite color (not yellow, it can’t be seen).
· B, I, U buttons
· Our first paragraph is still selected.
· Step 1 – Click on the Bold button. Ask students what changed.
· Step 2 – Click on the Italics button. Ask students what changed.
· Step 3 – Click on the Underline button. Ask students what changed. 
· Ask students: “what do you see right beside the underline button?”
· An arrow for options.
· Step 4 – Click on the options arrow for underline.
· Step 5 – Select a different underline style.
· Comprehension Check: students make 3 font changes to the second paragraph.
· Remind students that they need to select what they want to change. If they don’t select the second paragraph, they won’t see any changes.
· Instructor walks around the room to assist students who get stuck.
· Ask students where they might use some of these font formatting tricks in the future. Write their answers on the whiteboard.

(15) Formatting Paragraph
· Explanation/Discussion
· Just like we changed the font, we have paragraph formatting options to manage paragraph spacing and alignment.
· Activity: Adjust the paragraph alignment for the date.
· Ask students: “How many people have moved text on a page using this method?” 
· Click in front of the date and press the space bar several times.
· Most of your students should raise their hands.
· We don’t want to spend that much time manually manipulating our document. We want as much work as possible to be done by the computer.
· Step 1 – Highlight the date.
· Teacher’s Tip: I use highlight because then students don’t have to try to remember when they can just click in a paragraph to edit something versus select all the text they want to effect to edit it. Plus, it sets them up to change the alignment on multiple paragraphs in the future.
· Step 2 – Click on the Align Text Right button.
· The text is now automatically on the right margin of the page.
· Ask students: “If we hit this button to get to the right margin, which button do you think we want to use to get to the exact center of the page?”
· Step 3 – Click the Align Text Center button.
· Ask students: “What does this last alignment button do?”
· Many of your students will click it, but because you currently only have date selected, they will not see a difference.
· Step 4 – Select your first full paragraph.
· Step 5 – Click the Justify button.
· Now both sides of the text are completely aligned with the margin.
· We didn’t see a difference with the date because there wasn’t enough text to reach the right margin.
· Activity: Adjust paragraph spacing.
· Explain that Word has started doing some weird stuff with paragraph spacing. It looks great when you have big blocks of text, like in a letter, but it doesn’t always look that great. When you have an address, the spacing look atrocious.
· Step 1 – Scroll to the bottom of your letter.
· Step 2 – Type the library’s address as the return address.
· Teacher’s Tip: Tell students it is OK for them to type in just their first name on one line and city on another if they are slower typers.
· There is a huge space between their name and their address. This looks bad.
· Ask students: “What’s the first thing we do whenever we edit something?”
· Step 3 – Select all the text.
· Step 4 – Click on the Line Spacing button in the paragraph group.
· Step 5 – Click Remove Space After Paragraph.

(10) --BREAK!!!-- 

(10) Bullets
· Activity: add a bulleted list to your letter. 
· Explain: we want to create a bulleted list to send to Mom along with our letter that tells her what we do in a typical day.
· Step 1 – Press Enter a couple times to give yourself some space on the page.
· Step 2 – Click the bullets button.
· Point out the arrow beside the bullets button. Ask students what it does.
· Step 3 – Type in “Wake Up”.
· Step 4 – Press Enter to get to the next line and bring up your next bullet.
· Step 5 – Type in “Make the bed”.
· Step 6 – Press Enter.
· Step 7 – Type in “Eat Breakfast”.
· Explain: we want to create a list of what we eat for breakfast in a typical day. This doesn’t belong on the same line as our activities because it is specifically related to “Eat Breakfast”. We are going to create sub-bullets.
· Step 8 – Press Enter. 
· Our first step will always be to bring up our next bullet point.
· Step 9 – Click the Increase Indent button in the paragraph group.
· The bullet moves in on the page and changes shape.
· Teacher’s Tip: I use the buttons instead of Tab because it is a visual cue about what they are going to do. They aren’t memorizing key strokes, they are looking for an action. I cover Tab and Double Enter at the end of this section if the students easily pick up sub-bullets using the buttons first.
· Step 10 – Type in “Oatmeal”.
· Step 11 – Press Enter.
· The bullet stayed on the same indent.
· Step 12 – Type in “Eggs”.
· Step 13 – Press Enter.
· Step 14 – Type in “Orange Juice”.
· Explain that now we want to go back to our main list.
· Ask students: “What do we always do first when working in a bulleted list?”
· Step 15 – Press Enter.
· Step 16 – Click on the Decrease Indent button.
· Our bullets moved back in line with our main list and changed shape to match our main bullet points.
· Step 17 – Type in “Walk the Dog”.
· Step 18 – Hit Enter 2 times to leave the list and go back to normal typing.
· Comprehension Check: Students create their own list of daily activities.
· Instructor walks around the room to help students who are stuck.
· If there is time and the students picked up bullet points, show them Tab and Double Enter instead of Increase Indent and Decrease Indent buttons.

(5) Spell Check
· Explanation/Discussion 
· We don’t want to print out documents that have grammar or spelling mistakes, so we want to double check we didn’t mess anything up.
· Activity: Spell check a document when there are only a couple pages. 
· The first option we have to perform a spell check is either as we go or for a document that is only a couple pages long.
· When there is a word misspelled, there is a red squiggly line under it.
· Step 1 – Right click on the misspelled word (peple).
· The options menu has a list of word choices at the top to select from.
· Step 2 – Select the correct spelling from the list of words.
· When there is a grammar mistake, there is a blue squiggly line under it.
· Step 1 – Right click on the grammar error (been  hard).
· Step 2 – Select the option for the correct grammar.
· Not much changed. In this case, the grammar mistake was I accidentally hit the space bar 2 times between words instead of just one. 
· This method works great for short documents or for mistakes you notice as you are working, but it’s not the best for longer documents.
· Activity: Run a spell check. 
· Step 1 – Use undo on your revisions that fixed the spelling and grammar errors.
· Step 2 – Go to the Review tab.
· Step 3 – Click on Spell Check.
· Use the sidebar to navigate through all spelling and grammar errors.
· Word finds all the errors on the page.
· If you like a suggested change Word offers, click on Change.
· If it offers a suggestion for something like your name, click Ignore.
· If it doesn’t offer a good suggestion, you can always edit the text in the field.

(5) Margins and Page Layout
· Explanation/Discussion 
· Ask students: “What is a margin?”
· It is the white space around the outside of a page.
· Ask students: “Why would we want to adjust a margin?”
· Give the page more space. Especially with resumes, page space is a premium.
· Activity: Adjust the margins of the letter.
· Step 1 – Go to the Page Layout tab.
· Step 2 – Click on Margins.
· Step 3 – Select Narrow.
· Point out how much the text on the page moved up.
· Explain: never go smaller than a Narrow– it just looks bad.

(15) Saving
· Explanation/Discussion 
· We are going to spend 15 minutes talking about a topic that we have an hour and a half class for. If you have any problems with this topic, please come back and visit us for Computer Basics: Saving and Finding Files.
· Save v. Save As
· Save As is for new documents or when you want to save an additional copy of a document.
· Save is for saving changes made to a previously saved document.
· Activity: Save Document1 to the desktop. 
· Ask students: “Since this is a new file I’m saving, will I use Save or Save As?”
· Step 1 – Click on the File tab.
· Step 2 – Click on Save As.
· Step 3 – Click on Browse.
· Step 4 – Walk through the dialog box that opens.
· Choose a Location: 
· Automatically selects My Documents for new docs.
· If you want to change where the file is saved, use the left hand navigation pane to pick another location.
· E: = Flashdrive
· Desktop = Desktop
· Choose a Name:
· Ask students: “how many people think I would be able to find a specific letter I wrote if it was just titled whatever word wanted to title it?”
· Rename the document “Letter To Mom June 2015”
· Teacher’s Tip: Explain that we might want the date in the title because if we write many letters to Mom, we want to be able to find the specific one we are looking for.
· Step 5 – Click Save.
· Minimize all your screens to see the file on the desktop.
· Activity: Save changes made to the document. 
· Make a minor change to the document, like move your signature down the page.
· Ask students: “Do we need the old version of this document or just the changes we’ve made?”
· Step 1 – Click on the File tab.
· Step 2 – Click on Save.
· We didn’t get a dialog box because it overwrote the previous file with the changes we made to the document.
· Comprehension Check: Save or Save As? Ask the students to answer the following questions as a group (don’t let one person answer them all).
· You have updated your resume with your new address, save or save as?
· You want to create a duplicate copy of your resume so you can tailor it for a different type of job application, save or save as?
· You finished typing up a letter you started earlier, save or save as?
· You just started a new document, save or save as?
· You want to try out some new stuff you just learned in Word on a document, but you’re afraid of messing up the original, save or save as?

(5) Printing
· Activity: Print the document.
· Step 1 - Click on the File tab.
· Step 2 – Click on Print.
· You see a Print Preview to determine if the document looks the way you want.
· Step 3 – Click Print.
· Point out how to increase the number of copies of the document you print.
· Step 4 – Click OK.
(10) Homework
· Explain:
· Students are expected to practice for at least 2 hours for each class.
· Every library has both internet and Word on their computers. Please practice at a location that is convenient for you!
· Word tutorials at gcflearnfree.org. 
· Step 1 – Go to gcflearnfree.org.
· Step 2 – Click on the Microsoft Office tile.
· Step 3 – Click on Word 2013.
· Step 4 – Assign tutorials on Saving and Sharing Documents, Text Basics, Formatting Text, Page Layout, Printing Documents, Line and Paragraph Spacing, Lists.

(5) Conclusion 
· Go over handout, review material, emphasize contact info & further resources on handout.
· Any questions? Final comments? 
· Remind to take survey.
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Key Decisions
· We use right click to teach copy and paste instead of hot keys or clipboard options because it shows patrons a more universally available tool.
· We take a break before covering bullets because it is usually one of the hardest to grasp concepts in this lesson plan. A break lets our patrons come to it with a fresh brain and they absorb it easier.
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